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ABSTRACT 

The main aim of this project is to design and construct a hand movement controlled device 

switching system for physically challenged. The user can wear this device to hand and with the 

simple hand movement’s he/she can request the basic needs like water, food or medicine by 

using tilt sensor. User can also control the electrical devices like light, fan etc with the help of 

head movements. For example if the tilt is to the right side then the device will be “ON” for the 

first time then next time it will be “OFF”. In the same way, if the tilt is to the left side then 

another device is going to be controlled.  The tilt is in upwards or downward direction the related 

need will be announced. This device is very helpful for paralysis and physically challenged 

persons. This project makes use of a Relay for switching the devices and using android app voice 

commands are enabled for audio announcements and Micro controller, which is programmed, 

with the help of embedded assembly instructions. This microcontroller is capable of 

communicating with transmitter and receiver modules. The tilt sensor detects the hand angle 

movement and provides the information to the microcontroller (on board computer) and the 

controller judges whether the instruction is right movement or left movement instruction and 

controls the operation respectively. 

 

1. INTRODUCTION 

1.1 OVERVIEW 

This project is to design and construct a 

head movement controlled device switching 

system for physically challenged. The user 

can wear this device to hand and with the 

simple hand movement’s he can request the 

basic needs like water, food or medicine by 

using MEMS Sensor (tilt sensor). User can 

also control the electrical devices like light, 

fan etc with the help of hand movements. 

For example if the tilt is to the right side 

then the device will be “ON” for the first  

 

time then next time it will be “OFF”. In the 

same way, if the tilt is to the left side then 

another device is going to be controlled.  

The tilt is in upwards or downward direction 

the related need will be announced. This 

device is very helpful for paralysis and 

physically challenged persons.This project 

makes use of a Relay for switching the 

devices and APR-33A3 voice chip for audio 

announcements and Micro controller, which 

is programmed, with the help of embedded 
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assembly instructions. This microcontroller 

is capable of communicating with 

transmitter and receiver modules. The 

MEMS based sensor detects the movement 

of tilt sensor and provides the information to 

the microcontroller (on board computer) and 

the controller judges whether the instruction 

is right movement or left movement 

instruction and controls the operation 

respectively. 

1.2 EXISTING SYSTEM 

Previously the system doesn’t consist for 

physically handicapped people. But certain 

system is developed for dumb persons to 

enable the voice while any obstacle is found 

in their path.  

There after some developments are made to 

control the device wireless with the help of 

ir sensor. The ir sensor is wearable for 

heads, in practicable it is not much useful 

for the paralyzed persons. Also the system is 

developed with basic level microcontrollers. 

1.3 PROPOSED SYSTEM 

The proposed system is designed and 

developed for paralyzed persons. The 

proposed system is developed from the basic 

idea of author [1]. 

The system comprises of two sections 

named as Patient Wearable Section (PWS) 

and Control and Voice enable Section 

(CVS). The two sections uses ARDUINO 

UNO microcontroller to monitor and control 

the I/O signal from the sensors. Tilt sensor is 

used as input devices which can easily 

wearable for patient body. The tilt sensor is 

used to give data whenever a change occurs 

in its direction of angle.  

The CVS section uses a ARDUINO UNO 

based ATmega328P microcontroller which 

control the different electrical loads and 

enable the voice commands. APR33A3 

voice chip, Relay, loads are used .  

 

Fig.1.1 Block Diagram PWS (Patient 

Wearable Section) 

 

Fig.1.2 Block Diagram of CVS (Control & 

Voice enable Section) 

2. LITERATURE SURVEY 

Yu-Luen Chen  This study describes the 

motivation and the design considerations of 

an economical head-operated computer 

mouse. In addition, it focuses on the 

invention of a head-operated computer 

mouse that employs two tilt sensors placed 

in the headset to determine head position 

and to function as simple head-operated 

computer mouse. One tilt sensor detects the 

lateral head-motion to drive the left/right 

displacement of the mouse. The other one 

detects the head's vertical motion to move 

up and down with respect to the 

displacement of the mouse. A touch switch 

device was designed to contact gently with 

operator's cheek. Operator may puff his 

cheek to trigger the device to perform single 

click, double clicks, and drag commands. 

This system was invented to assist people 
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with disabilities to live an independent 

professional life. 

        Md.R.Ahsan, Muhammad I.Ibrahimy, 

Othman O.Khalifa With the ever increasing 

role of computerized machines in society, 

Human Computer Interaction (HCI) system 

has become an increasingly important part 

of our daily lives. HCI determines the 

effective utilization of the available 

information flow of the computing, 

communication, and display technologies. In 

recent years, there has been a tremendous 

interest in introducing intuitive interfaces 

that can recognize the user's body 

movements and translate them into machine 

commands. For the neural linkage with 

computers, various biomedical signals 

(biosignals) can be used, which can be 

acquired from a specialized tissue, organ, or 

cell system like the nervous system. 

Examples include Electro-Encephalogram 

(EEG), Electrooculogram (EOG), and 

Electromyogram (EMG). Such approaches 

are extremely valuable to physically 

disabled persons. Many attempts have been 

made to use EMG signal from gesture for 

developing HCI. EMG signal processing and 

controller work is currently proceeding in 

various direction including the development 

of continuous EMG signal classification for 

graphical controller, that enables the 

physically disabled to use word processing 

programs and other personal computer 

software, internet. It also enable 

manipulation of robotic devices, prosthesis 

limb, I/O for virtual reality games, physical 

exercise equipments etc. Most of the 

developmental area is based on pattern 

recognition using neural networks. The 

EMG controller can be programmed to 

perform gesture recognition based on signal 

analysis of groups of muscles action 

potential. This review paper is to discuss the 

various methodologies and algorithms used 

for EMG signal classification for the 

purpose of interpreting the EMG signal into 

computer command. 

            Jose Sellek,Wunnava Subbarao, 

Hussein Khorram  The authors present 

several sensing mechanisms and associated 

electronics developed to sense and monitor 

eye blinking and head nodding. The 

muscular vibrations around the eye are 

sensed by a piezoelectric crystal, a 

mechanical eye-blink sensor that provides 

the same information about eye-blinking as 

the optical sensor. An eight-plate metallic 

castle with a rotating metallic ball is the 

basis for the head movement or nodding 

sensor. The relative position of the ball 

within the castle provides information about 

the head movement. Sixteen head positions 

can be configured, providing very valuable 

information about the rate of head 

movement and pattern of head movement. 

              W. J. Perkins and B. F. Stenning 

For those severely physically disabled 

persons who are unable to use keyboards, 

the computer has to be adapted to operate 

from the limited signals that can be obtained 

from controlled movements. These 

movements need to be identified and 

appropriate devices provided which can 

produce suitable signals to operate a 

computer. To minimize programming effort, 

it is also necessary to standardize on a 

particular form of input signal-in our case, 

one or two on/off contacts-for which the 

programs are developed. It is desirable for 

user input devices to be linked to the 
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computer through an Interface Control Unit, 

which can also be operated from a remote 

infra-red unit mounted on a wheelchair. 

Such units are described. 

3  SOFTWARE IMPLEMENTATION 

3.1 ARDUINO SOFTWARE IDE 

USER’S GUIDE 

Arduino is an open-source project, enabling 

hobbyists to easily take advantage of the 

powerful Atmega chips. The Arduino IDE is 

the software where you can write code and 

upload it to the Atmega chip. The code is 

then executed on the chip. Most 3D-printer 

electronics are Arduino-compatible, they use 

the Atmega chip and enable the user to 

upload their code using Arduino. This 

includes Megatronics, Minitronics and 

RAMPS. Before you can start using the 

electronics you need software 'firmware', 

that translates machine instructions (gcode) 

into actual movements. There are a few 

options here, including Marlin and Sprinter 

and Repetier. The actual firmware is not 

discussed in this document. You can use 

Arduino to upload this firmware onto your 

electronics. This document will guide you in 

the steps you need to take. 

To upload a firmware, you must first open 

the files using File → Open. Select the .ino 
file from the directory containing the 

firmware. Arduino will open several tabs 

with files. Next step is to select the correct 

electronics board. From the Tools menu, 

locate the Board item. This item should 

include a few sub items, including 

Megatronics, Minitronics, Arduino mega 

2560 (RAMPS with mega 2560) and 

Arduino Mega 1280 (RAMPS with 

mega1280). Select the board that fits your 

electronics. Also we need to select the serial 

port the electronics is connected to. In the 

Tools menu, locate the Serial port item. This 

should include at least one item if the board 

is connected and the drivers are installed 

properly. If there are multiple items here, 

you need to find out which is the correct one 

by unplugging the board and checking 

which port was removed. Once you have set 

the board and serial port, you can upload the 

firmware by pressing File → Upload. 
Arduino will try to compile the firmware, if 

any errors occur the process will stop and 

you will need to fix the errors before trying 

again. Once compilation is complete, the 

actual upload will start. This may take a 

minute for a large sketch. 

Program Structure: 

All Arduino programs have two functions, 

setup() and loop(). The instructions you 

place in the startup() function are executed 

once when the program begins and are used 

to initialize. Use it to set directions of pins 

or to initialize variables. The instructions 

placed in loop are executed repeatedly and 

form the main tasks of the program. 

Therefore every program has this structure  

void setup()  

{ // commands to initialize go here  

}  

void loop()  

{ // commands to run your machine go here  

} 

The absolute, bare-minimum, do-nothing 

program that you can compile and run is 

void setup() {} void loop() {} The program 

performs no function, but is useful for 
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clearing out any old program. Note that the 

compiler does not care about line returns, 

which is why this program works if typed all 

on one line. 

 

 

 

 

 

 
4 SCHEMATIC DIAGRAM 

4.1 SCHEMATIC DIAGRAMS 

 
TX- SECTION 

 
RX SECTION 
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5.2. FLOW CHART 

PWS SECTION 

 

 
CONCLUSION 

In this paper, we proposed a controlling of 

electrical loads and voice enable for basic 

needs by the movement of head using IR 

sensors for physically challenged persons 

and electrical devices is controlled by using 

different types of twilts of head and the 

basic needs of food ,water and some other 

basic needs are designed by the apr voice 

circuit with the help of voice ic. This 

microcontroller is capable of communicating 

with transmitter and receiver modules. . 

Presence of every module has been reasoned 

out and placed carefully thus contributing to 

the best working of the unit. Secondly, using 

highly advanced IC’s and with the help of 

growing technology the project has been 

successfully implemented. 
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